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PREFACE

PREFACE
Thank you for purchasing the Garmin
StreetPilot® c510™.

®

Manual Conventions

When you are instructed to “touch”
something, use your ﬁnger to touch an
item on the screen.
You will see small arrows (>) used in the
text. They indicate that you should touch
a series of items. For example, if you
see “touch Where to? > Favorites” you
should touch the Where to? button, and
then touch Favorites.

c510 Tips and Shortcuts
• To quickly return to the Menu page,
touch and hold Back.
• Touch
and
to see more
choices.
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Tell us how you like this manual!
Fill out the Product Documentation
Survey. Go to www.garmin.com/
contactUs/, and click Product
Documentation Survey.

Quick Links

• Finding an address: page 7
• Viewing the Map page: page 12
• Using the Garmin Lock™ antitheft feature: page 6
• Transferring ﬁles to your c510:
pages 16–17
• Adjusting the volume: page 6
• Adjusting the brightness: page 6
• Cleaning and storing your unit:
page 23
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PREFACE

Warning
Failure to avoid the following potentially
hazardous situations could result in an
accident or collision resulting in death or
serious injury.
When installing the unit in a vehicle, place the
unit securely so that it does not interfere with
vehicle operating controls or obstruct the driver’s
view of the road (see diagram).
Do not mount
where driver’s
ﬁeld of vision
is blocked.

Do not place
unsecured on
the vehicle
dash.
Do not mount in front of an
airbag ﬁeld of deployment.

When navigating, carefully compare information
displayed on the unit to all available navigation
sources, including information from street signs,
visual sightings, and maps. For safety, always
resolve any discrepancies or questions before
continuing navigation.

Always operate the vehicle in a safe manner.
Do not become distracted by the unit while
driving, and always be fully aware of all driving
conditions. Minimise the amount of time spent
viewing the screen of the unit while driving and
use voice prompts when possible. Do not input
destinations, change settings, or access any
functions requiring prolonged use of the unit’s
controls while driving. Pull over in a safe and
legal manner before attempting such operations.
The unit contains a non-user-replaceable,
rechargeable lithium-ion battery. The battery
may present a risk of ﬁre or chemical burn if
mistreated.
•

Do not remove from the unit, heat unit above
140°F (60°C), or incinerate.

•

Dispose of unit properly. Contact your local
waste disposal department for information on
properly disposing of lithium-ion batteries.

WARNING: This product, its packaging, and its components contain chemicals known to the State
of California to cause cancer, birth defects, or reproductive harm. This Notice is being provided
in accordance with California’s Proposition 65. If you have any questions or would like additional
information, please refer to our Web site at http://www.garmin.com/prop65.

iv
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Caution
Failure to avoid the following potentially
hazardous situations may result in injury or
property damage.
The unit is designed to provide you with route
suggestions. It does not reﬂect road closures
or road conditions, trafﬁc congestion, weather
conditions, or other factors that may affect safety
or timing while driving.
Use the unit only as a navigational aid. Do not
attempt to use the unit for any purpose requiring
precise measurement of direction, distance,
location, or topography. This product should

not be used to determine ground proximity for
aircraft navigation.
The Global Positioning System (GPS) is
operated by the United States government,
which is solely responsible for its accuracy
and maintenance. The government’s system
is subject to changes which could affect the
accuracy and performance of all GPS equipment,
including the unit. Although the unit is a
precision navigation device, any navigation
device can be misused or misinterpreted and,
therefore, become unsafe.

Important Information

MAP DATA INFORMATION: One of the goals of Garmin is to provide customers with the most
complete and accurate cartography that is available to us at a reasonable cost. We use a combination of
governmental and private data sources, which we identify in product literature and copyright messages
displayed to the consumer. Virtually all data sources contain inaccurate or incomplete data to some
degree. This is particularly true outside the United States, where complete and accurate digital data is
either not available or prohibitively expensive.
NOTICE TO DRIVERS IN CALIFORNIA AND MINNESOTA: State law prohibits drivers in
California and Minnesota from using suction mounts on their windshields while operating motor
vehicles. Refer to page 22 for instructions on using the included mounting disk with the suction cup
mount. Garmin does not take any responsibility for any ﬁnes, penalties, or damages that may be incurred
as a result of disregarding this notice. (See California Vehicle Code Section 26708(a); Minnesota Statutes
2005, Section 169.71.)
NOTICE: This Category II radiocommunication device complies with Industry Canada Standard RSS310.
c510 Owner’s Manual
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Product Registration

Help us better support you by
completing our online registration today!
Connect to our Web site at www.garmin
.com/registration/.
Use this area to record the serial number
(8-digit number located on the back
of the c510) in case your c510 needs
service. Keep the original sales receipt,
or a photocopy, in a safe place.
Serial Number: ____ ____ ____ ____
____ ____ ____ ____

Contact Garmin

Contact Garmin if you have any
questions while using your c510. In
the U.S.A. contact Garmin Product
Support by phone: 913/397.8200 or
800/800.1020, Monday–Friday,
8 AM–5 PM Central Time; or go to
www.garmin.com/support/, and click
Product Support.
In Europe, contact Garmin (Europe) Ltd.
at 44/0870.8501241.
vi

Software License
Agreement

BY USING THE c510, YOU AGREE TO BE
BOUND BY THE TERMS AND CONDITIONS
OF THE FOLLOWING SOFTWARE LICENSE
AGREEMENT. PLEASE READ THIS
AGREEMENT CAREFULLY.
Garmin grants you a limited license to use
the software embedded in this device (the
“Software”) in binary executable form in the
normal operation of the product. Title, ownership
rights, and intellectual property rights in and to
the Software remain in Garmin.
You acknowledge that the Software is the
property of Garmin and is protected under the
United States of America copyright laws and
international copyright treaties. You further
acknowledge that the structure, organization, and
code of the Software are valuable trade secrets
of Garmin and that the Software in source code
form remains a valuable trade secret of Garmin.
You agree not to decompile, disassemble, modify,
reverse assemble, reverse engineer, or reduce to
human readable form the Software or any part
thereof or create any derivative works based on
the Software. You agree not to export or re-export
the Software to any country in violation of
the export control laws of the United States of
America.
c510 Owner’s Manual
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GETTING STARTED
What’s in the Box?

c510 unit and vehicle suction cup mount.
12-Volt adapter to provide external power or FM TMC Trafﬁc receiver (Deluxe
versions only) to provide external power and trafﬁc information.
USB cable to connect the c510 to your computer. Your c510 connects to your
computer as a Mass Storage Device (see pages 16–17).
Dashboard Disk to mount the suction cup mount on your dashboard (see page 22).
DVD-ROM (Deluxe versions only) to use the mapping software on a computer.
Yellow Sheet that contains your unit’s serial number, registration number for
registering on Garmin’s Web site, and unlock code for future reference.

Looking at Your c510
Ball socket (for attaching
the suction mount

SD card slot
MCX connector under rubber cap
(for an optional external antenna)
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Power
connector

Volume knob
Speaker

Mini-USB
connector

Power
button
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GETTING STARTED

Step 1: Mounting the c510

Select a suitable location to mount the c510 on your windscreen. Clean and dry the
selected area of your windscreen.

➊

➋
➌
Windscreen

1. Plug the power cable into the back of the c510.
2. Place the suction cup on the windscreen. Flip the lever back, toward the
windscreen.
3. Snap the socket on the back of the c510 onto the ball at the end of the suction cup
mount.
4. Plug the power cable into a power receptacle in your vehicle. Your unit should turn
on automatically if it is plugged in and your vehicle is running.

To remove the c510 from the mount, turn the c510 as far as you can to the right or left.
Apply pressure in that direction until the c510 snaps off the mount.
To remove the suction cup from the windscreen, ﬂip the lever toward you. Pull the tab
on the suction cup toward you.

2
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Step 2: Conﬁguring the c510

To turn on your c510, press and hold the Power button on the side of the unit.
Follow the on-screen instructions to conﬁgure your c510.

Step 3: Acquiring Satellites

Go outdoors to an open area, away from tall buildings and trees. Turn on the c510.
Acquiring satellite signals may take 30–60 seconds.
The
bars in the upper-left corner indicate satellite strength. When the bars are
green, your c510 has acquired satellite signals; you can ﬁnd your destination and go
to it.

Step 4: Using the c510
A Touch to ﬁnd a destination.
B Touch to view the map.
C Touch to view trafﬁc incidents, when an

FM trafﬁc receiver is connected.

A
B

D Touch to adjust the c510’s settings.
E Touch to adjust the brightness of the

screen.
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C

D

E
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Finding Your Destination

The Where to? menu provides several different categories for you to use when you
search for locations.

➊

➋

➌

Touch Where to?.

Select a category.

Select a sub-category.

➍

➎

➏

Select a destination.
Touch the arrows to see
more places.

Touch Go!.

Enjoy the route!

TIP: Touch
4

and

to see more choices.
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Following Your Route

As you travel, your c510 guides you to your destination with voice prompts, arrows
on the map, and directions at the top of the Map page. If you depart from the original
route, your c510 recalculates the route and provides new directions.

Your route is marked with a
magenta line.

Follow the arrows as you
take turns.

A checkered ﬂag marks your
destination.

Adding a Stop to Your Route

You can add a stop to your route. The c510 gives you directions to the stop and then to
your ﬁnal destination.
1. With a route active, go to the Menu page, and touch
Where to?.
2. Search for the extra stop.
3. Touch Go!.
4. Touch Yes to add this stop before your destination.
Or, touch No to make this your new ﬁnal destination.
NOTE: You can add only one stop to your route.
c510 Owner’s Manual
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Adding a Detour

If a road on your route is closed, you can
take a detour.
1. With a route active, touch Menu.
2. Touch Detour.

Stopping the Route

1. With a route active, touch Menu.
2. Touch Stop.

Taking a Better Route

As you approach your destination, the
c510 evaluates road options, which may
result in a better route. When the c510
ﬁnds a better route,
appears in the
right corner of the map. Touch
to
take the better route.

Adjusting the Volume

Turn the volume knob on the right side
of the unit to adjust the volume.

Adjusting the Brightness
On the Menu page, touch
. Touch
to lower the brightness and to raise
6

it. Touch OK when you are done.

Locking Your c510

1. On the Menu page, touch
>
System.
2. Touch the button next to Garmin
Lock. Touch OK.
3. Enter a 4-digit PIN. Touch Yes to
accept the PIN.
4. Touch OK. Drive to a security
location, and touch Set.

Each time you turn on the c510, enter
the 4-digit PIN or drive to the security
location.

What is a Security Location?

You can select any location, such as
your home or ofﬁce, for your security
location. If you are at your security
location, you do not need to enter a PIN.
If you forget your PIN, drive to your
security location to unlock the c510.
NOTE: To unlock your c510 at your
security location, the c510 must have
acquired satellite signals.
c510 Owner’s Manual
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WHERE TO?
The Where to? menu provides several
different categories used to search for
locations. To learn how to perform a
simple search, see page 4.

Finding an Address

1. From the Menu page, touch
Where to? >
Address.
2. Select a country and state, if
necessary.
3. Touch Spell City/Postal Code. Enter
the city/postal code, and touch Done.
4. Select the city/postal code in the list.
5. Type the number of the address, and
touch Done.
6. If necessary, enter the street name,
and touch Done.
7. Select the correct street in the list.
8. Touch the address, if necessary.
Touch Go! to create a route to this
address.
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TIP: Finding an intersection is very
similar to ﬁnding an address. Touch
Intersection, and enter the two
street names.

Go! Page Options

Touch an item in the search results list to
view the Go! page.

Touch Go! to create a turn-by-turn route
to this location.
Touch Show Map to view this location
on the map. If the GPS is off, touch
Set Loc. to select this as your current
location.
Touch Save to save this location as one
of your Favorites. See page 10.
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Go Home

You can set a home location for the place
you return to most often.
1. From the Menu page, touch
Where to? >
Go Home.
2. Select an option.

Going Home

Once your home location is set, you can
route to it at any time by touching
Where to? >
Go Home.

Changing Your Home
Location

To change your home location, you must
ﬁrst delete it from Favorites:
1. From the Menu page, touch
Where to? >
Favorites.
2. Touch HOME > Edit > Delete > Yes.

After you delete your home location,
reset it by following the steps in the “Go
Home” section above.

8

Finding Points of Interest

1. From the Menu page, touch
Where to? >
Food, Hotels….
2. Select a category and a sub-category,
if necessary. (Touch the arrows to see
more categories.)
3. Select a destination.
4. Touch Go!.

Finding a Place by Spelling
the Name

If you know the name of the location you
are looking for, you can spell it using the
on-screen keyboard. You can also enter
letters contained in the name to narrow
the search.
1. From the Menu page, touch
Where to? >
Food, Hotels….
2. Touch Spell Name.
3. Using the on-screen keyboard, enter
letters in the name. Touch Done.
4. Touch the place you are looking for,
and touch Go!.
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Using the On-Screen
Keyboard

When an on-screen keyboard appears,
touch a number or letter to enter it. Use
the keyboard to spell words just like
computer keyboard.

Finding Recently Found
Places

Your c510 stores the last 50 of your
recent ﬁnds in the Recently Found list.
The most recently viewed places appear
at the top of the list. From the Menu
page, touch Where to? >
Recently Found to view your
recently found items.

Deleting Recently Found
Places
Touch
to enter numbers.
Touch
to delete the last character
entered; touch and hold
to delete the
entire entry.
Touch
to change the keyboard
mode to use diacritical characters or
special characters.
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To remove all places from the Recently
Found list, touch Clear. Then touch Yes.
NOTE: When you touch Clear, all
items from the list are removed. It
does not delete the actual place from
your unit.
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Favorites

You can save places in your Favorites
so you can quickly ﬁnd them and create
routes to them. Your home location is
also stored in Favorites.

Editing Saved Places

1. From the Menu page, touch
Where to? >
Favorites.
2. Touch the location you want to edit.
3. Touch Edit.

Saving Places You Find

1. After you have found a place you
want to save, touch Save.
2. Touch OK. The place is saved in
Favorites.

Finding Saved Places

1. From the Menu page, touch
Where to?.
2. Touch
Favorites. Your saved
locations are listed.

Saving Your Current Location

From the Map page, touch the
vehicle icon. Touch Yes to save your
current location.

10

4. Touch a button to edit the location:
Touch Change Name. Enter a new
name, and touch Done.
Touch Change Map Symbol. Touch
a new symbol.
Touch Change Phone Number.
Enter a phone number, and touch
Done.
Touch Delete to remove this item
from the Favorites list. Touch Yes.
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Finding a Place Using the
Map
Use the Browse Map page to view
different parts of the map. Touch
Where to? >
>
Browse Map.

Tips for Browsing the Map

• Touch the map and drag to view
different parts of the map.
• Touch and to zoom in and out.
• Touch any object on the map. An
arrow appears pointing at the object
you selected.
• Touch Back to return to the previous
screen.
• Touch Save to save this location to
your Favorites.
• Touch Go to navigate to the selected
location.
• If the GPS is off, touch Set Loc.
to set your current location to the
selected location.
c510 Owner’s Manual

Expanding Your Search

1. From the Menu page, touch
Where to? > Near.
2. Select an option:
Where I Am Now—searches for
places near your current location.
A Different City—searches for
places near the city you enter.
My Current Route—searches for
places along the route you are
currently navigating.
My Destination—searches for places
near your current route destination.
3. Touch OK.
NOTE: Your c510 automatically
searches for places near your current
location.
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USING THE MAIN PAGES
Map Page

On the Menu page, touch
View map to open the Map page. The
shows your current location.
To save your current location, touch
the vehicle icon, and touch Yes.
Touch

vehicle icon

Touch the text bar to open
the Turn List page.

to zoom out.

Touch

to zoom in.

Touch Menu to return
to the Menu page.
Touch Arrival or
Speed to open the
Trip Information page.

Touch Turn In to open
the Next Turn page.
Map Page while Navigating a Route

Trip Information Page
12

Turn List Page

Next Turn Page
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Trip Information Page

The Trip Information page displays
your current speed and provides helpful
statistics about your trip. To view the
Trip Information page, touch Speed or
Arrival on the Map page.

Resetting Trip Information

If you want accurate trip information,
reset the trip information before
beginning a trip. If you make frequent
stops, leave the c510 turned on so it can
accurately measure elapsed time during
the trip.
Touch Reset Trip to reset the
information on the Trip Information
page. Touch Reset Max to reset the
maximum speed.
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Turn List Page

When you are navigating a route, the
Turn List page displays turn-by-turn
instructions for your entire route and the
distance between turns. Touch the green
text bar on the top of the Map page to
open the Turn List page. Touch a turn on
the list to view the Next Turn page for
that turn. Touch Show Map to view the
entire route on the Browse Map.

Next Turn Page

When you are navigating a route, the
Next Turn page shows the turn on the
map and the distance and time left before
you reach the turn. To view an upcoming
turn on the map, touch Turn In on the
Map page, or touch any turn from the
Turn List page.
Touch
and
to view other
turns in the route. When you are ﬁnished
viewing the Next Turn page, touch Back.

13

USING FM TRAFFIC

USING FM TRAFFIC
Use the FM TMC (Trafﬁc Message
Channel) trafﬁc receiver to receive
trafﬁc information broadcast over the
FM Radio Data System. When a trafﬁc
message is received, your c510 displays
the incident on the map and can change
your route to avoid the trafﬁc incident.
For coverage areas, refer to
the Garmin Web site at www.garmin
.com/fmtrafﬁc.
NOTE: The FM trafﬁc receiver and
c510 must be in data range of an FM
station transmitting TMC data to
receive trafﬁc information.
NOTE: Garmin is not responsible
for the accuracy of the trafﬁc
information. The FM trafﬁc receiver
simply receives signals from the
trafﬁc service provider and shows
that information on your c510.
NOTE: You can only access the
trafﬁc information if the c510 is
connected to an FM trafﬁc receiver.
14

Viewing Trafﬁc Incidents

1. On the Menu page, touch
to
display a list of trafﬁc incidents.
2. Select an item to view details.
3. Select an option.

Trafﬁc Symbols
International

Meaning

North
American

Road Condition
Road
Construction
Congestion
Accident
Incident
Information

Severity Color Code

The bars to the left of the trafﬁc symbols
indicate the trafﬁc incident’s severity:

Green = Low severity; trafﬁc is ﬂowing
normally.
Yellow = Medium severity; trafﬁc is a
bit congested.
Red = High severity; trafﬁc is heavily
congested or stopped.
c510 Owner’s Manual
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Avoiding Trafﬁc

NOTE: You do not need to activate
the subscription included with your
FM trafﬁc receiver (if it came with
one). The subscription activates
automatically after your c510
acquires satellite signals while
receiving trafﬁc signals from the pay
service provider.

The Map page displays
when there is
a trafﬁc incident on your current route or
on the road on which you are traveling.

Adding a Subscription

1. From the Map page, touch
.
2. Select an item to view details.
3. Touch Avoid.

Purchasing an Additional
Trafﬁc Subscription
If your subscription expires, you can
renew it at Garmin’s FM Trafﬁc Web
site at www.garmin.com/fmtrafﬁc. You
can purchase additional subscriptions at
www.garmin.com/fmtrafﬁc.

c510 Owner’s Manual

1.
2.
3.
4.

On the Menu page, touch
.
Touch
Trafﬁc.
Touch Add.
Write down the FM trafﬁc receiver’s
unit ID. Go to www.garmin.com/
fmtrafﬁc to purchase a subscription
and get a code.
5. After you have the 25-character
code, touch Next on the c510, and
enter the code.
6. Touch Done.

The trafﬁc subscription code cannot be
reused. You must obtain a new code each
time you renew your service. If you own
multiple FM trafﬁc receivers, you must
obtain a new code for each receiver.
15
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MANAGING FILES ON YOUR
C510
You can store ﬁles, such as JPEG image
ﬁles, in the c510’s internal memory or on
an optional SD card.

Step 1: Insert an SD Card
(Optional)
To insert or remove the card, press it in
until it clicks.

NOTE: The c510 is not compatible
with Windows® 95, Windows 98,
or Windows Me operating systems.
This is a common limitation of most
USB mass storage devices.

Supported File Types

• JPEG and JPG image ﬁles for splash
screen (see page 21)
• GPI custom POI ﬁles from Garmin’s
POI Loader (see page 27)
• GPX waypoint ﬁles from MapSource
(see page 26)
• Maps from MapSource®

Step 2: Connect the USB
Cable
1. Plug the small end of the USB cable
into the mini-USB connector.

2. Connect the larger end of the USB
cable to an available USB port on
your computer.
16
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Two additional drives appear in your
computer’s list of drives. “Garmin”
is the available storage in the c510’s
internal memory. The other removable
disk drive is the SD card.
NOTE: On some operating systems,
the c510 drives may not be named
automatically. See your operating
system’s Help ﬁle to learn how to
rename the drives.

Step 3: Transfer Files to
Your c510

1. Connect the c510 to your computer.
2. Double-click
My Computer.
3. Browse your computer for the ﬁle you
want to copy.
4. Highlight the ﬁle, and select File >
Edit > Copy.
5. Open the “Garmin” drive or the SD
card drive.
6. Select File > Edit > Paste. The ﬁle
appears in the list of ﬁles on the c510
memory or SD card.
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Step 4: Eject and Unplug
the USB Cable

When you are ﬁnished transferring ﬁles,
double-click the
Unplug or Eject
icon in your Windows system tray.
Select USB Mass Storage Device, and
click Stop. Select the c510 drives, and
click OK. You can unplug the USB cable
from your c510 now.

Deleting Files from Your
c510

With the c510 connected to your
computer, open
My Computer.
Open the “Garmin” or SD card drive.
Highlight the ﬁle that you want to
delete, and press the Delete key on your
computer’s keyboard.
CAUTION: If you are not sure
about a ﬁle’s purpose, do NOT
delete it. Your c510 memory contains
important system ﬁles that should
NOT be deleted. Be especially
cautious of ﬁles located in folders
entitled “Garmin.”
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CUSTOMISING THE C510

CUSTOMIZING THE C510
1. From the Menu page, touch
.
2. Touch the setting you want to change.

3. Touch the button next to the setting
name to change it.

Changing the Map
Settings
From the Menu page, touch
Map.
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>

Map Detail—adjust the amount of detail
shown on the map. Showing more detail
may cause the map to redraw slower.
Map View—change the perspective of
the map.
• Track Up—display the map in 2
dimensions (2D) with your direction
of travel at the top.
• North Up—display the map in 2D
with North at the top.
• 3D—display the map in 3 dimensions
(3D) in Track Up.
Vehicle—touch Change to change the
icon used to display your position on
the map. Touch the icon you want to
use, and then touch OK. Download
additional vehicle icons at www.garmin
.com/vehicles.
Map Info—view the maps loaded on
your c510 and their version. Touch a
map to enable (check mark) or disable
(no check mark) that map.
Restore—restore the original map
settings.
c510 Owner’s Manual
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Changing the System
Settings
From the Menu page, touch
System.

>

GPS Mode—enable and disable
GPS and WAAS/EGNOS. See www
.garmin.com/aboutGPS/waas.html for
information about WAAS/EGNOS.
Safe Mode—turn on or off Safe Mode.
When your vehicle is moving, Safe
Mode disables all functions that require
signiﬁcant operator attention and could
become a distraction while driving.
Garmin Lock—turn on Garmin Lock™
to lock your c510. Enter a 4-digit PIN,
and set a security location. For more
information, see page 6.
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Proximity Alarms—turn on or off the
alerts when you approach Custom POIs.
This option is only visible if you have
loaded Custom POIs. See page 27 for
more information about Custom POIs.
About—display your c510’s software
version number, unit ID number, and
audio version number. You need this
information when you update the system
software (see page 25) or purchase
additional map data (see page 26).
Restore—restore the system settings.

Localizing Your c510
From the Menu page, touch
Locale.

>
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To change a setting, touch the button
next to the icon. To change all settings,
touch Change All. In each screen, touch
the setting you want, and then touch
Next.
Locale—select your location.
Text Language—change all
on-screen text to the selected language.
Changing the text language does not
change the language of user-entered data
or map data, such as street names.
Voice Language—change the
language for voice prompts.
Time Format—choose a 12-hour,
24-hour, or UTC time format.
Time Zone—select a time zone or
nearby city from the list.
Daylight Saving—set to On, Off , or
Auto, if it is available.
Units—Change units of measure to
Kilometers or Miles.
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Changing the Navigation
Settings
From the Menu page, touch
Navigation.

>

Route Preference—select a preference
for calculating your route. Select Faster
Time to calculate routes that are faster
to drive but can be longer in distance.
Select Shorter Distance to calculate
routes that are shorter in distance but can
take more time to drive.
Vehicle Type—specify your vehicle type
to optimize routes.
Avoidances—select the road types you
want to avoid on your routes. The c510
uses these road types only if alternative
routes take you too far out of your way
or if no other roads are available. If you
c510 Owner’s Manual
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have an FM trafﬁc receiver, you can also
avoid trafﬁc incidents.
Attention Tone—turn on or off the
attention tone.
Restore—restore the original navigation
settings.

Screen Shot—enable Screen Shot mode.
Touch the
camera icon to take a
picture of the current screen. The bitmap
ﬁle is saved in the Garmin\scrn folder
on the “Garmin” drive.

Customizing the Display

1. From the Menu page, touch
2. Touch Restore.

From the Menu page, touch
Display.

>

Restoring All Settings

.

Clearing User Data

CAUTION: This deletes all userentered information.

Color Mode—select Daytime for a
light background, Nighttime for a dark
background, or Auto to automatically
switch between nighttime and daytime.
Splash Screen—select an image to be
shown when you turn on the c510. First,
load JPEG images using USB Mass
Storage Mode (see pages 16–17).
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1. Hold your ﬁnger on the lower-right
corner of the c510’s screen while
turning on the c510.
2. Keep your ﬁnger pressed until the
pop-up window appears.
3. Touch Yes to clear all user data.

All original settings are restored. Any
items that you have saved are erased.
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APPENDIX

Resetting Your c510

Mounting on Your Dashboard

Use the enclosed mounting disk to
mount your unit to the dashboard and to
comply with certain state regulations.
Important: The permanent mounting
adhesive is extremely difﬁcult to remove
after it is installed.
To install the mounting disk:

1. Clean and dry the dashboard where
you are placing the disk.
2. Remove the backing from the
permanent mounting adhesive on the
bottom of the disk.
3. Place the disk on the dashboard.
4. Place the suction cup mount on top of
the disk. Flip the lever down (toward
the disk).
Suction
cup
mount

If your unit locks up (freezes up), press
and hold the Power button to turn off
the unit. Then turn the unit back on. If
this does not help, reset your c510.
To reset the c510:

1. Place your thumb nail in the groove
located under the Garmin logo on the
faceplate.
Reset button
2. Gently pull off
the faceplate.
3. Press the
Reset button.
4. Connect the
Faceplate Power button
c510 to a
power source using the power cable.
The c510 should automatically turn
back on and operate normally.
NOTE: If you need to reset your unit
often, update the system software.
See page 25 for information about
updating the software.

Lever
Disk
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Caring for Your c510

Your c510 contains sensitive electronic
components that can be permanently
damaged if exposed to excessive shock
or vibration. To minimise the risk of
damage to your c510, avoid dropping
your unit and operating it in high-shock
and high-vibration environments.

Cleaning the Unit

The c510 is constructed of high-quality
materials and does not require user
maintenance other than cleaning. Clean
the unit’s outer casing (not the touch
screen) using a cloth dampened with
a mild detergent solution, and then
wipe dry. Avoid chemical cleaners
and solvents that can damage plastic
components.

Cleaning the Touch Screen

Clean the touch screen with a soft, clean,
lint-free cloth. Use water, isopropyl
alcohol, or eyeglass cleaner, if needed.
Apply the liquid to the cloth, and then
gently wipe the touch screen.
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Protecting Your c510

• Carry and store your c510 in the
included carry case.
• Do not store the c510 where
prolonged exposure to extreme
temperatures can occur (such as in
the boot of a car), because it can
cause permanent damage.
• Do not expose the c510 to water.
Contact with water can cause this unit
to malfunction.
• Though a PDA stylus can also be
used to operate the touch screen,
never attempt this while operating
a vehicle. Never use a hard or sharp
object to operate the touch screen;
damage may result.

Avoiding Theft

• To avoid theft, remove the c510
and mount from visible sight when
not in use. Remove the mark on the
windscreen left by the suction cup.
• Do not keep the c510 in the glove
compartment; thieves look there.
23

APPENDIX

• Register your product at
www.garmin.com/registration. This
may help if your unit is stolen.
• Use the Garmin Lock™ feature. See
page 6.

Changing the Fuse

An AGC/3AG 2-Amp, high-breaking
capacity, 1500 A-rated fuse is located
at the tip of the vehicle adapter.
Periodically, you may
need to change the fuse.
Unscrew
Unscrew the black,
round end piece, and
replace the fuse.

Using a Remote Antenna

You can use an optional external remote
antenna (GA 25MCX). To purchase, go
to the Garmin Web site at www.garmin
.com/products/sp510, and click the
Accessories link.
Remove the weather cap from the
antenna connector located on the left of
the c510, and connect the antenna.
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About Satellite Signals

Your c510 must acquire satellite signals
to operate. If you are indoors, near tall
buildings or trees, or in a parking garage,
the c510 cannot acquire satellites.
Go outside to an area free from tall
obstructions to use your c510. When the
c510 has acquired satellite signals, the
signal strength bars on the Menu page
are green
. When it loses satellite
signals, the bars turn red or disappear
. For more information about GPS,
visit www.garmin.com/aboutGPS.

Charging the c510

To charge the c510, connect the power
cable to the c510 and a power source.

Calibrating the Screen

If the touch screen is not responding
properly, calibrate the touch screen.
Turn the unit off. Press and hold the
Power button for about one minute until
the Calibration screen appears. Follow
the on-screen instructions.
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Battery Information

Your unit contains an internal (nonremovable) lithium-ion battery. The
battery should last up to 8 hours,
depending on usage.
The
battery icon in the corner of
the Menu page indicates the status of the
internal battery. If the icon is not present,
the c510 is connected to external power.
Contact your local waste disposal
department for information on properly
disposing of the unit.

Maximizing the Battery Life

• Turn off GPS (
>
System
> GPS Mode > GPS Off) when you
do not need to receive GPS signals,
or use Normal mode when you do
not need to use WAAS or EGNOS.
• Turn the backlight brightness down
(on the Menu page, touch
).
• Do not leave your c510 in direct
sunlight. Avoid prolonged exposure
to excessive heat.
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Updating the c510
Software

Use WebUpdater to update your c510
software. Go to www.garmin.com/
products/webupdater/ to download the
WebUpdater program.
After downloading WebUpdater to your
computer, connect your c510 to your
computer, run WebUpdater, and follow
the screen prompts. After conﬁrming
that you want to perform an update,
WebUpdater automatically downloads
the update and installs it on your c510.
If you register your c510, you will
receive e-mail notiﬁcation of software
and map updates. To register your c510,
go to www.garmin.com/registration/.
You can also download software updates
from www.garmin.com/products/
sp510. Click Software Updates. Click
Download next to the unit software.
Read and agree to the terms. Click
Download. Select Run (or Open). Your
software is updated.
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Purchasing and Loading
Additional MapSource
Maps

To ﬁnd out the version of the maps that
are loaded on your c510, open the Menu
page. Touch
>
Map > Map
Info. To enable additional maps, you
need your unit ID (see page 19) and
serial number (see page vi).
Check www.garmin.com/unlock/update
.jsp to see if an update for your map
software is available.
You can also purchase additional
MapSource map data from Garmin and
load the maps on your c510’s internal
memory or on an optional SD card.
To load maps to your c510 memory
or SD card, select the name for your
“Garmin” drive or SD card drive. Refer
to the MapSource Help ﬁle for more
information about using MapSource and
loading maps on your c510.
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Loading MapSource
Waypoints on Your c510

Using MapSource, you can save
locations (also called waypoints) and
transfer them to your c510. For more
information about creating waypoints in
MapSource, see the Help ﬁle (press F1
to open the Help ﬁle).

After you have created the waypoints,
select File > Save. Select GPS
eXchange Format (*.gpx) for the Save
as Type. Click the Save button.
With your c510 connected to your
computer, copy the *.gpx ﬁle into the
Garmin\gpx folder in the “Garmin”
drive. The waypoints you created in
MapSource are now in Where to?
>
Favorites.
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Viewing Your Saved
Locations in MapSource

You can also view the locations you have
saved in your c510 using MapSource.
In MapSource, select File > Open.
Select GPS eXchange Format (*.gpx)
for Files of Type. Browse to ﬁnd the
Garmin\gpx folder on your “Garmin”
drive. Select Current.gpx, and click
Open.

Custom POIs (Points of
Interest)

Load custom points of interest (POIs)
onto your c510. POI databases are
available from various companies on
the Internet. Some custom databases
contain alert information for points, such
as safety cameras and school zones.
You will receive a warning if you are
traveling too fast near these custom
POIs.
Use the Garmin POI Loader to load POIs
into your unit. Download the POI Loader
from www.garmin.com/extras.
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Using the POI Loader program, you
can store the Custom POIs on your
“Garmin” drive or your SD card. You
can also customise the proximity alert
settings for each POI using the POI
Loader. Refer to the POI Loader Help
ﬁle for more information; press F1 to
open the Help ﬁle.
To view your Custom POIs, touch
Where to? >
Extras >
Custom POIs.
To delete the Custom POIs from
your c510, connect your c510 to your
computer. Open the Garmin\poi folder
in the “Garmin” drive or the SD card
drive. Delete the ﬁle entitled poi.gpi.
CAUTION: Garmin is not
responsible for the consequences
of using a custom POI database or
the accuracy of the safety camera or
other custom POI databases.
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Troubleshooting
Problem/Question

Solution/Answer

My c510 never gets
satellite signals.

Take your c510 outside, away from tall buildings and
trees.

How do I know my
c510 is in USB Mass
Storage Mode?

When your c510 is in USB Mass Storage Mode, a picture
of a c510 connected to a computer is shown. Also, you
should see two new removable disk drives listed in My
Computer.

My computer never
shows that the c510
is connected.

1. Unplug the USB cable from your computer.
2. Turn the c510 off.
3. Plug the USB cable into your computer and your
c510. The c510 automatically turns on and goes into
USB Mass Storage Mode.

I cannot ﬁnd any
drives named
“Garmin” in my list of
drives.

If you have network drives mapped on your computer,
Windows may have trouble assigning drive letters to your
c510 drives. See the operating system’s Help ﬁle to learn
how to rename and assign (map) your drives.

I get a message
saying “Unsafe
Removal of Device”
when I unplug the
USB cable.

When you are ready to disconnect your c510 from your
computer, double-click the
Unplug or Eject icon in
your system tray. Select USB Mass Storage Device,
and click Stop. Select the c510 drives, and click OK. You
can disconnect your c510 from your computer now.
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Technical Speciﬁcations

Physical size: 4.4” W x 3.2” H x 2.2” D
(11.2 x 8.2 x 5.6 cm)
Weight: .59 pounds (269 g)
Display: 2.8” W x 2.1” H (7.2 x 5.4 cm);
320 x 240 pixels; bright, 16-bit LCD,
with white backlight and touch screen
Case: Not waterproof
Temperature range: 32°F to 140°F
(0°C to 60°C)
Data storage: Internal memory and
optional removable SD card. Data stored
indeﬁnitely.
Computer interface: USB mass storage,
plug-and-play
Charge time: Approximately 4 hours
Power input: 12/24 VDC
Usage: 15 W max. @ 13.8 VDC
Battery life: up to 8 hours depending on
usage

GPS Performance
Speciﬁcations

Receiver: WAAS enabled
Acquisition times*:
Warm: <1 sec
Cold: <38 sec
Factory Reset: <45 sec
*On average for a stationary receiver
with a clear view of the sky
Update rate: 1/sec, continuous
GPS accuracy:
Position: <10 meters, typical
Velocity: 0.05 meter/sec RMS
GPS (WAAS) accuracy:
Position: <5 meters, typical
Velocity: 0.05 meter/sec RMS
For a complete list of speciﬁcations,
see www.garmin.com/products/sp510/
spec.html.

CAUTION: The c510 is not
waterproof.
c510 Owner’s Manual
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FCC Compliance

The unit complies with Part 15 of the FCC
interference limits for Class B digital devices
FOR HOME OR OFFICE USE. These limits are
designed to provide more reasonable protection
against harmful interference in a residential
installation, and are more stringent than “outdoor”
requirements.
Operation of this device is subject to the
following conditions: (1) This device may not
cause harmful interference, and (2) this device
must accept any interference received, including
interference that may cause undesired operation.
This equipment generates, uses, and can radiate
radio frequency energy and, if not installed
and used in accordance with the instructions,
may cause harmful interference to radio
communications. However, there is no guarantee
that interference will not occur in a particular
installation. If this equipment does cause harmful
interference to radio or television reception, which
can be determined by turning the equipment off
and on, you are encouraged to try to correct the
interference by one of the following measures:
•
•
•
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Reorient or relocate the receiving antenna.
Increase the separation between the
equipment and the receiver.
Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

•

Consult an experienced radio/TV technician
for help.
NOTE: The Garmin c510 has no userserviceable parts. Repairs should only be
made by an authorised Garmin service
center.
NOTE: Unauthorized repairs or
modiﬁcations could result in permanent
damage to the equipment, and void your
warranty and your authority to operated
this device under Part 15 regulations.
NOTE: The c510 is fastened shut with
screws. Any attempt to open the case to
change or modify the unit in any way
voids your warranty and may result in
permanent damage to the equipment.

Declaration of Conformity
Hereby, Garmin declares that this StreetPilot cseries product is in compliance with the essential
requirements and other relevant provisions of
Directive 1999/5/EC.
To view the full Declaration of Conformity, see
the Garmin Web site for your Garmin product:
www.garmin.com/products/sp510/. Click
Manuals, and then select the Declaration of
Conformity.
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Limited Warranty

This Garmin product is warranted to be free from
defects in materials or workmanship for one year from
the date of purchase. Within this period, Garmin will
at its sole option repair or replace any components that
fail in normal use. Such repairs or replacement will be
made at no charge to the customer for parts or labor,
provided that the customer shall be responsible for
any transportation cost. This warranty does not cover
failures due to abuse, misuse, accident, or unauthorized
alteration or repairs.
THE WARRANTIES AND REMEDIES
CONTAINED HEREIN ARE EXCLUSIVE AND IN
LIEU OF ALL OTHER WARRANTIES EXPRESS
OR IMPLIED OR STATUTORY, INCLUDING ANY
LIABILITY ARISING UNDER ANY WARRANTY
OF MERCHANTABILITY OR FITNESS FOR
A PARTICULAR PURPOSE, STATUTORY OR
OTHERWISE. THIS WARRANTY GIVES YOU
SPECIFIC LEGAL RIGHTS, WHICH MAY VARY
FROM STATE TO STATE.
IN NO EVENT SHALL GARMIN BE LIABLE
FOR ANY INCIDENTAL, SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, WHETHER
RESULTING FROM THE USE, MISUSE, OR
INABILITY TO USE THIS PRODUCT OR FROM
DEFECTS IN THE PRODUCT. Some states do not
allow the exclusion of incidental or consequential
damages, so the above limitations may not apply to
you.
Garmin retains the exclusive right to repair or replace
the unit or software or offer a full refund of the
purchase price at its sole discretion. SUCH REMEDY

SHALL BE YOUR SOLE AND EXCLUSIVE
REMEDY FOR ANY BREACH OF WARRANTY.
To obtain warranty service, contact your local Garmin
authorised dealer or call Garmin Product Support for
shipping instructions and an RMA tracking number.
The unit should be securely packed with the tracking
number clearly written on the outside of the package.
The unit should then be sent, freight charges prepaid,
to any Garmin warranty service station. A copy of
the original sales receipt is required as the proof of
purchase for warranty repairs.
Garmin International, Inc.
Tel. 913/397.8200 Fax. 913/397.8282
Garmin (Europe) Ltd.
Tel. 44/0870.8501241 Fax 44/0870.8501251
Online Auction Purchases: Products sold through
online auctions are not eligible for rebates or
other special offers from Garmin. Online auction
conﬁrmations are not accepted for warranty
veriﬁcation. To obtain warranty service, an original or
copy of the sales receipt from the original retailer is
required. Garmin will not replace missing components
from any package purchased through an online auction.
International Purchases: A separate warranty
is provided by international distributors for units
purchased outside the United States. This warranty
is provided by the local in-country distributor and
this distributor provides local service for your unit.
Distributor warranties are only valid in the area of
intended distribution. Units purchased in the United
States or Canada must be returned to the Garmin
service center in the United Kingdom, the United
States, Canada, or Taiwan for service.

For the latest free software updates (excluding map data)
throughout the life of your Garmin products, visit the Garmin
Web site at www.garmin.com.
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